Zeplin sketch file

Zeplin open sketch file. Export sketch file to zeplin. Zeplin sketch file download. How to upload sketch file to zeplin.
Freddy Montes|September 19, 2020Delivering interface designs to developers is not an easy task. Many designers try to create guidelines manually to show font sizes, colors, components, space, margins, etc. This takes a lot of work, and keeps it updated is a nightmare.Several applications serve to do this work in a more orderly and efficient way:
Invision, Avocado, and Zeplin, to name a few. In this post, I will explain how I use Zeplin to handle this important task.Table of contentWhy Zeplin?Automatically generate style guidesYou can organize your components in sections and groupsSynchronize directly with Sketch through an official pluginDownload assets, images in 1x, 2x, and 3x also
optimized SVGGood CSS code with variables and relative unitsWebapp availableCan be shared with the whole teamHas a free versionConnecting Zeplin and SketchAfter you create your account in Zeplin, the next step is to create a project.Create a Zeplin ProyectYou can do it from the Mac or Windows app:Installing the Sketch pluginOnce you install
Zeplin the Sketch plugin should install automatically, but if you have any problems download the plugin and click double click. Once you have done this, you should have it available under the plugins menu in Sketch:What do developers expect from the designer?Typeface: family, size, weight, space between characters and line spacingSpaces:
margins, padding and distance between elementsColorsSymbols or componentsAssets: images, photos etcZeplin gives you all this and also generates very good CSS code for this.Five things that cannot be missing in your Sketch fileTo demonstrate how to use Zeplin I made a small design in Sketch, you can download here.Consistent color
paletteZeplin automatically creates a color list of all the colors used in the Sketch document, so it is very important to be consistent with the use of colors. Create your color palette, add them to the document, and always pick colors from that palette.Use Text StylesIt allows you to store a set of styles and reuse them in different text layers within your
designs, thus maintaining consistency in your UI, more information on how to use it in the Sketch documentation.You can use any name in your Text Styles I separate them by where I use them, for example:Form / LabelButton / Primary / Label o Button / Secondary / LabelTypography / H1Typography / BodyConsistent spaceI use 8px as base space.
This means margins and paddings between the UI elements is based on multiples of 8 (8, 16, 24, 32, 40, 48, and so on).Using an even number like 8 in space and size elements in your design makes scaling for a wide variety of devices much more comfortable and consistent. If you want to know more about this technique, I recommend this post: How
to create stronger layouts with the 8pt Grid.Use SymbolsThe symbols in Sketch are a way to save and reuse common elements in your designs. Symbols are the most powerful tool in Sketch. For more information about symbols check the Sketch's documentation.Make the assets exportableBy doing this, you will allow developers to download assets
from Zeplin and even in different resolutions such as 1x, 2x, and 3x:Then in Zeplin, the developer will be able not only to inspect the image but also to download the png or jpg files for 1x, 2x, and 3x and also HTML code for responsive image:Setting up the project in ZeplinExport from SketchOnce you export all the artboards and pages from Sketch
:Plugins > Zeplin > Export All > Artboards from all pagesand then go to your Symbol page, select all of them andPlugins > Zeplin > Export SelectedWith this, you make sure to export absolutely the entire Sketch document to Zeplin.Adding and organizing content to ZeplinIf you open your project in Zeplin, you will see that there is an indicator in the
"Styleguide" tab, which means that Zeplin found colors and text styles to add to your project.Color PaletteWith a single click, you add all the colors that Zeplin found in your document:And it not only adds the colors, but it also generates the necessary CSS code, so the developer only has to copy and paste the code in his project:You can also change
the names and the order of the colors if you wish.Text Style CatalogAs with colors, Zeplin detects the Text Styles that your Sketch document has and suggests adding them with a single click:As with colors, it generates the CSS code so that developers only have to copy and paste:By default it uses the names that come from Sketch but you can change
them if you wish.Spacing and LayoutIn this section you can create "tokens" with the spaces that you use in your design. Since my design uses spaces of multiples of 8px I must create: 8, 16, 24, 32 and so on and I make sure to mark the checkbox to use measures rem:Using relative measures (rems) not only generates the CSS code with those
measures but when the developer is inspecting the design, he can see the name of the generated CSS variables, which will allow him to develop the page and the responsive and accessible components:ComponentsIn this section, the developer will be able to see all the Symbols that you created in your design in Sketch which serves as a guide for the
reusable components that the developer needs to create and as a bonus CSS code with the color and space variables:By default, they are all grouped in the same section but you can group them by section, select multiple components and then: Right click> New Section From SelectionYou can also organize it by groups, select multiple components in a
section Right Click> New Group from SelectionAnd you can also drag and drop components, groups and sections to organize better. By doing this, Sketch will automatically update all the components, and you organized them into Sections and Groups.SharingEverything is ready to send to your developer or development team. In Zeplin's project
dashboard, you click on the "Share" button:In the popup, you can invite the developers by email (the email with which they registered in Zeplin) or send them the link for both the web and the app. Both links are private, and only users invited to the project have access to them.Finally, Zeplin has the concept of "Scene" which is a public page where
you can share your design with everyone, this is 100% public, but you only activate it if you wish, here is the link of this project: you could see, Sketch and Zeplin allow you to pass in an orderly way and always in sync handoff the designs to the developers, including colors and fonts, sizes, spaces, etc.Zeplin can so do much more. For example, a
developer can link the code of its components, its repository, snippets, and even StoryBook with the Zeplin project. In the next post, I will do that process.Thank your read this blog post. Any feedback or question hit me up on Twitter.Tweet Me Learn how to publish your Sketch file to Zeplin ♀ Watch our tutorial to learn more about publishing designs
from Sketch:Exporting ArtboardsExporting artboards from a Sketch design to Zeplin is quite straightforward. To be able to export designs, you need to download the desktop app first.Once you have installed and opened up the desktop app, the Sketch plugin will be installed automatically. To export your artboards:Select any layer/artboard in your
Sketch file.Press ⌃⌘E or use the menu up top “Plugins > Zeplin > Export Selected…” to start the export process. On the project selection window, you can switch between your workspaces to choose the desired project.Exporting symbols work exactly the same as exporting artboards. Simply select a symbol or multiple symbols (which are usually
located in the Symbols page in Sketch) and press Control + Command + E to begin the export process. ♀ Keep in mind that Zeplin has 100 character limit for screen names. If your artboard has a name with more than 100 characters, it’ll be trimmed to 100 in Zeplin.☝ It's sadly not possible to import Sketch ﬁles directly into Zeplin since Zeplin works
with a plugin. If you don’t see the plugin in the Sketch menu, you can install it here.Seeing file locationZeplin shows the Sketch Cloud file location on the right panel of the screen both on the Mac app and the Web app, depending on members' roles in their workspaces:Free plan: All project membersTeam plan: Editor/Developer, Admin, and
OwnerOrganization plan: Editor, Admin, and OwnerEnterprise plan: Editor, Admin, and OwnerYou can directly open the design ﬁle in Sketch Cloud by clicking on the ﬁle name.☝ If you're working with a local Sketch ﬁle, Zeplin shows the ﬁle location if you're the user who exported that screen and you're using the same machine that you used to
export. Next up: Collaborating with your team Related articles: There is a project in Zeplin. Was trying to export it into Sketch but was only able to export scenes as PNG files. How is that possible to export them as '.sketch' ones so i could work with layers in Sketch? 2 Zeplin is a powerful collaboration tool that bridges the gap between designers and
developers by creating a connected space for product teams. Why Zeplin? A crucial piece of any product development puzzle is the place where design meets development. When a design is ready to move into the development phase (the “handoff”), engineers need a way to understand it and translate it into code. Zeplin facilitates the handoff by
taking designs from Sketch, Adobe XD, Figma, and Photoshop and exporting them into a format that can easily generate code snippets, style guides, specs, and assets. Say goodbye to the days of “redlining.” Zeplin is focused purely on improving the collaboration between product designers and development teams and is used by leading product teams
at Airbnb, Dropbox, Pinterest, Microsoft, and many others. With Zeplin there is no need to manually write out sizes or margins, type the copy, export icons. It’s simply awesome and saves lots of time to focus on design explorations. – Alex Potrivaev, Product Designer @Intercom Traditional design specifications, a.k.a. “redlining” before tools like
Zeplin. In one of our past articles, Toptal Designer Micah Bowers talked about the importance of having a standardized design language system in order to communicate efficiently across various functions of product teams working on digital products. By versioning design assets, creating component libraries, and generating living style guides, a
project ported into Zeplin can serve as the “single source of truth” for product teams. We basically consider Zeplin to be our source of truth for collaborating with Engineering. If it’s not in Zeplin, it’s not official. – Jason Stoff, Senior Designer, Digital Products @Starbucks Zeplin Limitations While Zeplin has many helpful features, it isn’t perfect.
Zeplin offers a free plan, but under that plan, it’s limited to one project. When designing for both iOS and Android, two separate projects will be required. At that point, a paid plan would be needed. Once the flow of working with Zeplin and Sketch (or the other apps mentioned above) is understood, the workflow becomes easy. However, Zeplin has a
bit of a learning curve that requires some time and attention. To see a general overview and learn more about how to use it, see the Zeplin demo video below: Working with Sketch and Zeplin: Steps and Tips 1. Get started with Zeplin. 2. Prepare your Sketch file. Now that we have Sketch and Zeplin ready to go, we’ll set up our Sketch file for a
seamless export to Zeplin. In Sketch, organize your assets and layers using consistent naming conventions. If collaborating with other designers, determine conventions that work for everyone on your team. Depending on what type of project this is (e.g., iOS, Android, or web), Zeplin will automatically adjust the assets’ naming convention, making
exporting them a one-step process. Create symbols for common elements and assets within Sketch. This will allow you to set up components in Zeplin. Save colors into your “Document Colors” palette and fonts as “Text Styles” in your Sketch file. These will show up in your Zeplin-generated style guide. 3. Make assets exportable in Sketch. This is a
very important step. Once your assets are grouped into symbols, open the Symbols page in your Sketch file. Click on a group within a symbol, such as “ic-menu” (the folder icon) With the group highlighted, locate the action “Make Exportable” on the lower right-hand side of your “Inspector” in Sketch and click on this option. A slice icon should now
appear next to your group’s name. This step will allow engineers to export assets directly from Zeplin. 4. Create a new project in Zeplin. Select the type of project you are building. Note that you should have separate projects for iOS and Android, even if the designs are identical. This is because Zeplin will generate different code based on the type of
the project. Select the project resolution which matches your Sketch artboards (e.g., 1x, 320px). 5. Export the Sketch artboards to Zeplin. From Sketch, highlight all artboards that you would like to export to Zeplin. Go to Plugins > Zeplin > Export Selected… or press ⌃⌘E on your keyboard. Next, we’ll export Symbols from Sketch. Open the Symbols
page in Sketch and highlight all artboards. Export to Zeplin. 6. Organize the project in Zeplin. Now that your Sketch artboards are in Zeplin, let’s organize artwork into sections. From the Dashboard view of your project, select similar screens to group into categories. Once highlighted, right click and select “New Section from Selection.” Repeat this
until your Zeplin file is properly organized. 7. Utilize components in Zeplin. Perhaps one of Zeplin’s most useful features is the ability to organize assets into component libraries. This is important when a project’s designs are developed for multiple platforms by different team members. Design unification is essential, as Airbnb designer Karri Saarinen
outlines in Building a Visual Language: A unified design system is essential to building better and faster; better because a cohesive experience is more easily understood by our users, and faster because it gives us a common language to work with. Select the “Styleguide” tab at the top center of Zeplin (next to “Dashboard”). Once in the “Styleguide”
tab, select the secondary tab, “Components.” Here, you will see all of your symbols exported from Sketch. Organize these into sections such as “Icons,” “Images,” “Common Elements,” etc. You can learn more about the Components tab of your project style guide in Zeplin here. 8. Export style guides from Zeplin. From the Dashboard view of your
Zeplin project, locate the “Share” button in the top right corner of the application. Select “Share,” then find “Scene” at the bottom of the menu. Select “Enable” and then “Open.” This will generate a dynamic style guide for your project. Share the URL with your team. 9. Annotate your designs in Zeplin. Adding notes to designs is easy with Zeplin.

From the detailed view of a screen, select the add note icon and pin your note to a component. You can add a note by holding down Cmd (Ctrl for Windows and Linux users) and clicking anywhere on the screen. You can even mention other teammates with “@” and they will receive a notification. 10. Collaborate, share, and use version control. Now
that your Zeplin file is ready to share with your team, invite users via their email address, or send them the project URL. Continue to update your Zeplin file by exporting artboards from Sketch. Zeplin will automatically version control your files and you can continue collaborating with team members using this dynamic “source of truth.” Conclusion
Creating a dynamic, organized, and collaborative workflow between design and development teams is essential for building great digital products. Having a workflow bridge like Zeplin empowers designers to annotate screens and eases the often dreaded handoff phase with complete and precise specifications. The flexibility to update assets
dynamically from one central source, like a symbol in Sketch exported to a component in Zeplin, creates tremendous flexibility. Engineers can then easily export assets into native code, saving time and tedium. While thoughtful UX and aesthetically beautiful designs are the root of a successful product, the process of getting that design into the hands
of users is critical. Designers wanting to be efficient and rely on a single “source of truth” should consider the Sketch to Zeplin workflow outlined above. The power behind the robust software relationship between these two design tools will help designers and development teams get to the finish line with greater ease and satisfaction. • • • Further
reading on the Toptal Design Blog: Zeplin is a plugin and standalone desktop application for Mac and Windows specifically designed to bridge the gap between designers and engineers. It takes designs from Sketch, Adobe XD CC, Figma, or Adobe Photoshop CC and exports them into a format which generates code snippets, design specs, and assets.A
code snippet in programming is a piece of reusable code. A "snippet" is a programming term for a small region of re-usable source code, machine code, or text. Ordinarily, these are formally defined operative units to incorporate into larger programming modules.Sketch is a comprehensive vector-based design toolkit on the macOS platform for
creating designs at various fidelities for various devices. It includes a comprehensive set of design tools, design library management, library styles, color management, reusable components, masking, and much more.What is a design language system?Design language systems allow diverse teams working on sophisticated digital products to
communicate using a standardized visual language. UI styleguides are woven into the fabric of design language systems and serve as a tool that can be relied on for quick iteration and consistent digital experiences.What is the process of product development?A product development process is taking a product or service from concept to market. The
process sets out a series of stages—typically around 7 or 8—that new products typically go through, beginning with ideation and concept generation, and ending with commercialization, the product's introduction to the market.
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